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1 Einleitung

Vielen Dank, dass Sie sich fur den Kauf eines PCE-GPA 62 von PCE Instruments entschieden haben.
Der Ein - Drei - Phasen - Netzanalysator (Graphic Power Quality Analyzer) PCE-GPA 62 dient zur ein-
oder dreiphasigen Messung von Wirk- Blind- und Scheinleistung, Leistungsfaktor, Phasenwinkel, Energie,
Spannung und Strom sowie deren Spitzen und Oberwellen bis zur 50. Harmonischen. Dabei stellt das
integrierte grafische Display eine optimale optische Verdeutlichung der Werte am Netzanalysator sicher.
Die Messdaten kdnnen geloggt, gespeichert und spater zum PC tbertragen und dann analysiert werden.
Der PCE-GPA 62 ist ein handliches Profigerat mit dem viele Parameter ohne aufwendige Messaufbauten
festgestellt werden kénnen

2 Sicherheitsinformationen
e Benutzen Sie den Analysator niemals flr Spannungen >600V
e Greifen Sie nicht Uber den oberen Rand der Klemme
e Benutzen Sie die Klemme oder Zubehor nicht wenn es beschadigt ist.
e Arbeiten Sie vorsichtig an hohen Spannungen
e Arbeiten Sie vorsichtig bei Messungen >30VAC RMS oder bei Messungen >60VDC
e Arbeiten Sie mit auBerster Vorsicht an offenen Leitungen und Stromschienen
e Benutzen Sie das Messegerat immer nur so wie in der Betriebsanleitung beschrieben

Bitte lesen Sie dieses Benutzer-Handbuch sorgféltig und vollstandig, bevor Sie das Gerat zum ersten Mal
in Betrieb nehmen. Die Benutzung des Gerates darf nur durch sorgféltig geschultes Personal erfolgen.

Dieses Benutzer-Handbuch wird von der PCE Deutschland ohne jegliche Gewahrleistung veroffentlicht.

Wir weisen ausdriicklich auf unsere allgemeinen Gewahrleistungsbedingungen hin, die sich in unseren
Allgemeinen Geschéftsbedingungen finden lassen.

Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH.



3 Spezifikationen

3.1 Leistung

BETRIEBSANLEITUNG

PCE Instruments

(50 oder 60 Hz, PF 0.5 bis 1.0, VT = 1, Spannung > 5V AC, Strom > 5A AC im A Be-reich, und

kontinuierliche Schwingung)

Bereich (0 bis 1500A) Auflésung Genauigkeit der Messung’

10.0 —999.9 W 0.1W >20Vund >20 A <20V<20A
1.000 — 9.999 KW 0.001 KW +1% +20dgts +2% +40dgts
10.00 — 99.99 KW 0.01 KW +1% +20dgts +2% +40dgts
100.0 — 999.9 KW 0.1 KW +1% +20dgts +2% +40dgts

1000 — 9999 KW 1 KW +1% +20dgts +2% +40dgts

'Bei VT #1, ist die Aufldsung in Prozent dieselbe (+1%). Die zusatzliche Angabe der Leistung muss mit

VT multipliziert werden

Beispiel: £0.2W wird £0.2W * VT

3.2 Scheinleistung

Scheinleistung (VA, von 0.000VA bis 9999 KVA, PF 0.5 bis 1)

Bereich (0 bis 1500A) Auflésung Genauigkeit der Messung’
10.0 — 999.9 VA 0.1 VA >20Vund>20A <20V<20A
1.000 — 9.999 KVA 0.001 KVA +1% +20dgts +2% +40dgts
10.00 — 99.99 KVA 0.01 KVA +1% +20dgts +2% +40dgts
100.0 — 999.9 KVA 0.1 KVA +1% +20dgts +2% +40dgts
1000 — 9999 KVA 1 KVA +1% +20dgts +2% +40dgts

"Bei VT #1, ist die Aufldsung in Prozent dieselbe (+1%). Die zusatzliche Angabe der Leistung muss mit

VT multipliziert werden

Beispiel: £0.2VA wird +0.2VA * VT

3.3 Blindleistung

Blindleistung (VAR, von 0.000 VAR bis 9999 KVAR)

Bereich (0 bis 1500A) Auflésung Genauigkeit der Messung’

10.0 — 999.9 VAR 0.1 VAR >20Vund >20A <20V<20A
1.000 — 9.999 KVAR 0.001 KVAR +2% +30dgts +3% +40dgts
10.00 — 99.99 KVAR 0.01 KVAR +2% +30dgts +3% +40dgts
100.0 — 999.9 KVAR 0.1 KVAR +2% +30dgts +3% +40dgts

1000 — 9999 KVAR 1 KVAR +2% +30dgts +3% +40dgts

"Bei VT #1, ist die Auflésung in Prozent dieselbe (+1%). Die zusatzliche Angabe der Leistung muss mit

VT multipliziert werden

Beispiel: £0.2VAR wird £0.2VAR * VT

Bereich von VT (Volt Transformer) Ratio: 1 bis 3000

Energie (Arbeit) (WH, oder KWH, von 0 WH bis 999.999 kWH)
Berechnung: WH =W * Time (in Stunden)
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Strom (50 oder 60 Hz, Auto Range, True RMS, Spitzenfaktor < 4, Uberlastschutz 2000A)

Bereich

Auflésung

Genauigkeit der Messung®

4.0 -1500.0 A

0.1A

+1.0% * 5dgts

3.5 Spannung

Spannung (50 oder 60 Hz, Auto Range, True RMS, Spitzenfaktor < 4, VT=1, Input Impedanz 10 MQ,

Uberlastschutz 800V)

Bereich

Auflésung

Genauigkeit der Messung®

4.0 - 600 V

0.1V

+0.5% =+ 5dgts

"Bei VT #1, ist die Aufldsung in Prozent dieselbe (+1%). Die zusatzliche Angabe der Digits muss mit VT

multipliziert werden

Beispiel: £0.2dgts wird £0.2dgts * VT

3.6 Oberwellen in der Spannung in Prozent

Oberwellen in der Spannung in Prozent (1 bis 50 Ordnung, Minimal Spannung bei 50 Hz oder 60 Hz >
AC 80V. Wenn die Spannung bei 50Hz 0V betrégt, wird 0 Prozent angezeigt.

Bereich Auflésung Genauigkeit der Messung®
1-20" 0.1% +2%
21 50" 0.1% 4% des gelesenen +2.0%

3.7 Oberwellen in der Spannung als absoluter Wert

Oberwellen in der Spannung als absoluter Wert (1 bis 50 Ordnung, Minimal Spannung bei 50 Hz oder 60

Hz >80V, VT=1)

Bereich Auflésung Genauigkeit der Messung®
1-20" 0.1 % +2% + 0.5V
21 -50" 0.1% 4% des gelesenen +0.5V

3.8 Oberwellen im Strom in Prozent

Bereich Auflésung Genauigkeit der Messung’
1-20" 0.1% +2%
21 50" 0.1% 4% des gelesenen +2,0%

3.9 Oberwellen im Strom als absoluter Wert

Bereich Auflésung Genauigkeit der Messung’

1-20" 0.1% +2% des gelesenen +0.4A

21 —-50" 0.1% +4% des gelesenen +0.4A
3.10 Leistungsfaktor
Leistungsfaktor (PF)

Bereich Auflésung Genauigkeit der Messung"

> 20V und > 20A < 20V oder < 20A
0.000 — 1.000 0.001 +0.04 +0.1

3.11 Phasenwinkel

Bereich Auflésung Genauigkeit der Messung’

-180° - 180° 0.1° +1°
0° - 360° 0.1° +1°
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Schwingungsstdérungen (THD-F unter Beachtung von 50 oder 60 Hz, min. Wert bei 50 oder 60 Hz >
80V und > 20 A, 1 bis 50t Schwingung. Wenn der Strom oder die Spannung bei 50Hz oder 60Hz O ist

werden 0% angezeigt.

Bereich Aufldsung Genauigkeit der Messung®
0.0—-20% 0.1% 2%

20.1 -100 % 0.1% * 6% des gelesenen = 1%

100.1 —999.9 % 0.1% +10% des gelesenen = 1%

3.13 Wert der Spitzenwerte von Strom und Spannung
Wert der Spitzenspannung (Spitzenwert > 10V) oder Spitzenstrom (Spitzenwert > 20A)

Bereich Auflésung Genauigkeit der Messung®
50 Hz 39 us + 5% + 50 Digits
60 Hz 33 us + 5% + 50 Digits

Frequenz (RMS Wert > 20V) oder ACA (RMS Wert > 30A)

Bereich

Auflésung

Genauigkeit der Messung®

46 — 65

0.1

+0.3Hz

LeitergrofRe

ca. @ 55mm, 65 x 24mm (Stromschienen)

Batterietyp

2*AA 1.5V

Display

128 X 64 Matrix LCD mit Hintergrundbeleuchtung

Messbereichsauswahl

Automatisch

Uberlastanzeige

OL

Stromverbrauch:

ca. 10mA

Automatische Abschaltung:

15 Min. nach dem Einschalten

Update Zeit

2 Wiederholungen/Sekunde (Display)
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4 Systembeschreibung

@

1. Zangenvorrichtung

2. Hebel zum Offnen der Stromzange

3. HOLD / CANCEL / Backlight — Mit dieser Taste kénnen die das Display einfrieren oder die
Hintergrundbeleuchtung ein- und ausschalten. Auf3erdem kann die Taste dazu verwendet werden die
Ober- und Unterwellen zu I6schen.

4. Wahlschalter — Verwenden Sie den Wabhlschalter um die Messmethode zu wéhlen

5. LCD — Punktmatrix Display mit Hintergrundbeleuchtung

6. + » Knopf — Wert um 1 erhdhen / Referenzachse nach Oben verschieben / Liniencursor nach rechts
verschieben / eine Seite weiter zum nachsten Ereignis

7. REC - Dricken Sie diesen Knopf um die Datenaufzeichnung zu starten. Ein erneutes driicken stoppt
die Aufnahme. Halten Sie den Knopf gedriickt und schalten Sie das Gerat ein um samt-liche Daten zu
I6schen. AuRerdem kdnnen Sie hiermit weitere Wellen in der Konfiguration hin-zufligen

8. - « Knopf —Wert um 1 verringern / Referenzachse nach unten verschieben / Liniencursor nach links
verschieben / eine Seite zuriick zum vorherigen Event

9. FUNC Knopf — Driicken Sie diesen Knopf um eine andere Anzeige zu erhalten

10. V-Eingangsbuchse — Eingangsbuchse fiir Spannung

11. COM-Buchse — Masse oder Referenzeingang

12. RS232-Fenster und Batteriefachdeckel
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5 Einstellungen

Drehen Sie den Wahlschalter in die SETUP-Position. Sie sollten vor der Messung die Einstellungen fir

die jeweilige Messung vornehmen.

Parameter auswihlen

CANCEL ¥¢
HOLD

OFF

3 Phase
1 Phase «

Vi -
Al

Transient -«

/\ 600V MAX CAT Il

Werte erhohen oder verringern

10
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5.1 Einstellmdglichkeiten im SETUP

R OFF:Y
$116.8 U

(o 10 156 20 25
26 30 3 0 & 5

CURRENT TIME: Einstellung der Aktuellen Uhrzeit fir den internen Kalender (H:MM)

SAMPLE: Einstellung fur die Datenaufnahme in Sekunden

START TIME: Einstellen der Uhrzeit zum Starten der Daten-aufzeichnung (H:MM)

STOP TIME: Einstellen der Uhrzeit zum Stoppen der Daten-aufzeichnung (H:MM)

VT: Einstellen des Messwandlungsverhaltnisses (Standard: 1) V(gelesen) = Spannung*VT

MD: Der MD (Maximum Demand) Zeitbereich liegt zwischen 1 und 60 Minuten. Wenn das Zeitintervall
eingestellt wurde, berechnet das Gerat die maximale Leistungsaufnahme und die durchschnittliche
Leistungsaufnahme in Watt (W) oder VA

HZ: Einstellen der Netzfrequenz (50Hz, 60Hz oder Auto)

AUTO POWER OFF: Automatische Abschaltung EIN (1) oder AUS (0)

TRANS REF: Einstellen der nominellen Spannung und der Schwelle(%) zur Schwingungsaufnahme

1 § 10 15 20 25
2 30 38 40 45 5

HARMONICS CONFIG: Stellt ein welche Ober- und Unterwellen aufgenommen werden sollen.

CANCEL ©
T Wellen 16schen

off
3Phnse, " .

1 Phase -

Vi

Al
Transisnt

C€ : sETUP”

-
{
m

ADO

B e
B N B Wellen hinzufligen

2\ B0CY MAX CAT

Wellen auswilhlen

11
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Hinweis: Das Messgeréat passt die Wiederholungszeit entsprechend der Anzahl der eingestellten
Schwingungen an.

] 10 15 20 28
2% 30 3% 40 445 80

WAVEFORM CONFIG: Stellt ein wie viele Punkte bei jedem Durchgang der Schwingungsanzeige
aufgenommen werden sollen. Vier Méglichkeiten sind einstellbar: 32, 64, 128, 256.

Hinweis: Das Messgeréat passt die Wiederholungszeit entsprechend der Anzahl der eingestellten
Schwingungen an.

Graphlc Power Quality Analyzer

1 5 10 15 20 25
26 30 35 4 45 50

DATE: Mdglichkeit zur Einstellung des aktuellen Datums fir den internen Kalender.
Format: JJ:MM:TT

12
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5.2 Messung des RMS Wertes, THD-F und Ober-/Unterwellen von Wechselspannung

//1

5.2.1 Spannungsmessung

a. Stellen Sie den Wabhlschalter in die ,V* — Position

b. Verbinden Sie die Messleitungen mit den entsprechenden Buchsen am Messgeréat (siehe Bild)

c. Halten Sie die Prufspitzen parallel an die Kontakte, welche Sie messen méchten.

Hinweis: Wenn die Spitzenspannung, der zu messenden Spannung, den Messbereich den Messgerates
Uberschreitet erscheint im Display ,OL".

RMS-Wert Graphic Power Quality Analyzer

Schwingung

5 10 16 20 25
2% 0 % 40 4 50

% THD-F: Absolute Verzerrung der Oberwellen unter Beriicksichtigung der Grundfrequenz.

13
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Graphic Power Quality Analyzer

[Liniencursor

V1: Wert bei Nominalfrequenz (50Hz / 60Hz)
V2: Wert bei 2. Schwingung

(/.50: Wert bei 50. Schwingung

CANCEL %
HOLD

3 Phase
1 Phase .

v lll. y
Al -
Transient «

SETUP OFF

2\ BOUV MAX CAT i

Cursor bewegen

,":ermnmmuumm',
) |

‘ 219,4 U &, b

2%:° 0.0 U 0,0

1 5 10
e

Hinweis: Die Frequenz wird auf der zweiten Seite angezeigt(Schwingungen von 25 bis 50)

14
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5.3 Messung des RMS Wertes, THD-F und Ober-/Unterwellen von Wechselstrom

5.3.1 Strommessung

a. Stellen Sie den Wabhlschalter in die ,A“- Position
b. Klemme Sie die Zange wie abgebildet um den Leiter. Achten Sie hierbei auf die Stromfluss-richtung.
c. Der Messwert wird anschlieend im Display angezeigt.

15
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5.4 Darstellung von ACV und ACA mit Phasenwinkel im Liniendiagramm

5.4.1 Darstellung von Strom und Spannung mit Phasenwinkel

Wenn Sie sich ACV und ACA im Diagramm anschauen médchten ist es notwendig, dass Sie die Zange um
den Leiter legen (Strommessung) und die Messleitungen parallel an die Kontakt halten
(Spannungsmessung).

CANCEL %
HOLD

3 Phase
1 Phose .

Vi -

Al -

Translent +

SETUP

Anzeige auswahlen

2\ 600V MAX CAT (11

Wenn Sie den Wabhlschalter in die Position zur Anzeige des Diagramms stellen zeigt das Messgeréat die
Spannung, den Strom und den Phasenwinkel an.

Wenn Sie die Tasten +» oder -« driicken kénnen Sie den Referenzachse fir die Spannung nach oben
oder unten verschieben.
So kdnnen Sie wie im folgenden Bild Strom und Spannung einfacher ablesen.

Graphic Power Quality Analyzer

16
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5.4.2 Darstellung von Spannung

Driicken Sie die FUNC-Taste um die Darstellung von Spannung mit RMS-Wert und Spitzenwert
anzuzeigen.

Graphic Power Quality Analyzer
7 U316,2

5.4.3 Darstellung von Strom
Driicken Sie die FUNC-Taste um die Darstellung von Strom mit RMS-Wert und Spitzenwert anzuzeigen.

Graphic Power Quality Analyzer

5.5

a. Stellen Sie den Wabhlschalter in die Position ,,1 Phase*

b. Verbinden Sie die Messleitungen parallel zum Verbraucher

c. Klemmen Sie die Zange um den Leiter, der zum Verbraucher fuhrt. Achten Sie hierbei auf die Strom
flussrichtung

Hinweis: Wenn der Spitzenwert fir Spannung oder Strom den Messbereich tUberschreitet zeigt das
Messgerat OL an.

Hinweis: Wenn das VT-Verhaltnis nicht 1 ist dann ist der angezeigt Wert gleich dem gemessenen Wert
(W, VA, VAR) multipliziert mit VT.

Bsp.: Wicp = Wiess* VT

17
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5.5.1 Messung von Leistung (W) und Leistungsfaktor (PF)

5.5.2 Messung von Scheinleistung (VA, KVA) und Blindleistung (VAR, KVAR)

Achtung: Sie missen fur diese Messung die automatische Abschaltung deaktivieren!

5.5.4 Messung von Energie (KWh, PFh, KVARh und KVAh)

Achtung: Sie mussen fur diese Messung die automatische bschaltung deaktivieren!

18
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5.5,5 Anzeige als Zeigerdiagramm

 EEEERTTER

5.5.6 Anzeige der RMS-Werte von Strom und Spannung

‘Graphic Power Quality Analyzer
X |

! Q v — |

5.6

L

| b

a. Stellen den Wahlschalter in die Position ,3 Phase”
b. Verbinden Sie die Testleitungen parallel zur Spannungsquellen zwischen L1 und L3
c. Klemmen Sie die Zange um den Leiter, der zum Verbraucher fuhrt. Achten Sie hierbei auf die

Stromflussrichtung
d. Driicken Sie die FUNC Taste um folgende Anzeigen zu erhalten

19
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5.6.1 Messung von Leistung (W) und Leistungsfaktor (PF)

Achtung: Sie missen fur diese Messung die automatische Abschaltung deaktivieren!

5.6.4 Messung von Energie (Arbeit) (KWh, PFh, KVARh und KVAh)

Achtung: Sie mussen fur diese Messung die automatische Abschaltung deaktivieren!

20
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5.6.5 Anzeige als Zeigerdiagramm

5.6.6 Anzeige der RMS-Werte von Strom und Spannung
‘Graphic Power Quality Analyzer

6 Aufzeichnung von Spannung (RMS-Wert) und Ober- / Unterwellen

6.1 Geplante Aufzeichnung
a. Stellen Sie den Wahlschalter in die ,V* Position

CANCEL %*

HOLD
3 Phase 0”-
1 Phase .

vie -
Al
Transient «

C€ SETUP .

B N B Start

ime - - o

)\ 600V MAX CAT I
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b. Wenn Sie folgendes Bild auf dem Display sehen driicken Sie die REC Taste und es startet die
Datenaufzeichnung mit der im Setup eingestellten Wiederholungsrate.

Graphic Power Quality Analyzer

Hinweis: Der erste RMS-Wert und die erste Schwingung werden immer aufgezeichnet.

c. Wenn Sie die REC Taste gedriickt haben erscheint folgende Anzeige

Graphic Power Quality Analyzer Graphic Power Quality Analyzer
TIME: 1138

i
‘{IME: 2130
TIME? 113328

g sec to start
press HULD butt

} 2130
TI Hlx'.!g

B sec Lo start
press HOLD button to
cel

1 5 W0 15 X 25
EEEEE Lo BB 2E

Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste flr 2
Sekunden lang halten.

Wenn die HOLD Taste nicht gedrtckt wird, wird die Aufzeichnung gestartet. Wenn die Daten-
aufzeichnung gestartet wurde blinkt die Led neben den Anschlussbuchsen.

Die Start- und Stoppzeit stellen Sie im SETUP ein.

6.2 Sofortige Datenaufzeichnung
Driicken Sie die REC Taste zweimal.

Die Startzeit wird automatisch fiir die folgende Minute festgelegt.
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag.

7 Aufzeichnung von Strom (RMS-Wert) und Ober-/Unterwellen

7.1 Geplante Aufzeichnung

a. Stellen Sie im SETUP eine Start- und Stoppzeit ein. Stellen Sie den Wahlschalter in die ,A“ Position
b. Um die Aufzeichnung zu starten, driicken Sie die REC Taste

C. Sobald die REC Taste gedriickt wurde erscheint folgende Anzeige im Display

Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste fir 2
Sekunden lang halten.

Wenn die HOLD Taste nicht gedriickt wird, wird die Aufzeichnung gestartet. Wenn die Daten-
aufzeichnung gestartet wurde blinkt die Led neben den Anschlussbuchsen

7.2 Sofortige Datenaufzeichnung

Driicken Sie die REC Taste zweimal.
Die Startzeit wird automatisch fur die folgende Minute festgelegt.
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag.
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8 Datenaufzeichnung von Spannungs- und Stromdiagrammen

8.1 Aufzeichnung der Kennlinie von Strom und Spannung

Setzen Sie den Wabhlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Driicken
Sie die FUNC Taste bis im Display die Wellen fir Strom und Spannung zu sehen sind.

Driicken Sie die REC Taste um die Datenaufzeichnung zu starten. Nun werden Strom und Spannung
aufgezeichnet.

Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen kénnen sie im SETUP einstellen.

8.2 Aufzeichnung der Spannungskennlinie

Setzen Sie den Wabhlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Driicken
Sie die FUNC Taste bis im Display die Welle Spannung zu sehen ist.

Dricken Sie die REC Taste um die Datenaufzeichnung zu starten.

Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen kénnen sie im SETUP einstellen.

8.3 Aufzeichnung der Stromkennlinie

Setzen Sie den Wabhlschalter in die Position zur Anzeige des Strom- und Spannungsdiagramms. Driicken
Sie die FUNC Taste bis im Display die Welle Spannung zu sehen ist.

Dricken Sie die REC Taste um die Datenaufzeichnung zu starten.

Hinweis: Die Anzahl der Punkte, die aufgenommen werden sollen kénnen sie im SETUP einstellen.

9 Datenaufzeichnung von Stérschwankungen
Stellen Sie den Wahlschalter in die Position ,Transient®. Auf dem Display wird Ihnen folgendes angezeigt:

Graphic Power Quality Analyzer

H ’

AGE: 40,8
ecord Numbers! P
pransient Status : (7

Es wird Ihnen die Referenzspannung (TRANS REF) von 110V mit einem Schwellwert von 5% angezeigt.
Wenn die Spannung 115,5V (SWELL) Uberschreitet oder die Spannung kleiner als 104,5V (DIP) ist oder
kleiner als 40V (OUTAGE) dann wird eine Stdérung aufgezeichnet.

Hinweis: Sie kbnnen maximal 32000 aufzeichnen.

Driicken Sie die FUNC Taste um die Erkennung von Stérschwankungen zu starten.
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CANCEL ¢
HOLD

OFF

3 Phase
1 Phase .

Vi -
A lll. .

Transient -

Z\ 800V MAX CAT Il

Nachdem Sie die FUNC Taste gedriickt haben wird die Anzeige geleert und die LED neben den

Anschlussbuchsen fangt an zu blinken.

Um die Aufzeichnung zu stoppen betétigen Sie erneut die FUNC Taste. Mit Hilfe der +» oder -« ist es
mdoglich zwischen den einzelnen Aufzeichnungen hin und her zuschalten.

Aufzeichnungsnummer

Spannung niedrig

Spannung hoch

Startzeit

Dauer
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Aufzeichnungsnummer = ,— Startzeit

‘Graphic Power Quality Analyzer
DIP “l & SOCSBC:"’U:_E ‘
) e g,c.','r_ LE Dauer
Spannung < 40 V s==0 4dsec2o('/CLE
sol : 8$C3

Spannung hoch SWELL), CLE |
'3 o MC?{LE |

10 Datenaufzeichnung der Leistung

Spannung niedrig

10.1 Geplante Aufzeichnung

Stellen Sie den Wahlschalter in die 3 PHASE Position. Driicken Sie die REC Taste einmal um die
Aufzeichnung zu starten. Stellen Sie vorher die Start- und Stoppzeitim SETUP ein.

CANCEL £
HOLD

3 Phase oFt

1 Phase .
vl -
Al -

Transient -+

SETUP

Start

Z\ 600V MAX CAT Il
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Wenn die REC Taste gedruckt wurde erscheint folgende Anzeige.

Graphic Power Quality Analyzer Guphlc Power Quality Analyzer
! 1823 R

} 2130
11130

Press HFLII button

\Cancel Jo
1 5 10 15 20 2 1 5 10 15 2 25
% %o 8 40 23 % 2 30 35 40 45 S0

Sie haben 8 Sekunden Zeit um die Aufzeichnung abzubrechen, wenn die die HOLD Taste fir 2 Se-
kunden lang halten.

Wenn die HOLD Taste nicht gedruckt wird, wird die Aufzeichnung gestartet. Wenn die
Datenaufzeichnung gestartet wurde blinkt die Led neben den Anschlussbuchsen.

Das Messgerat zeichnet 50.000 Werte (Datum/Zeit, VA, W, VAR, PF, KVAH, KWH, KVARH, PFH,
AD(VA), AD(W), MD(VA), MD(W), Phase, PS) auf.

10.2 Sofortige Datenaufzeichnung

Dricken Sie die REC Taste zweimal.
Die Startzeit wird automatisch fiir die folgende Minute festgelegt.
Die Stoppzeit ist die aktuelle Uhrzeit am folgenden Tag.

11 LoOschen des internen Datenspeichers

Um den Speicher des Datenloggers zu l6schen halten Sie die REC Taste und schalten Sie das Gerét ein.
Dricken Sie die HOLD Taste um das Léschen des Speichers zu bestétigen.

Wenn der interne Speicher komplett geléscht wurde, schaltet sich das Gerat automatisch ab.

'Graphic Power Quality Analyzer

Jo

1 5 10 15 20 25
2% 0 % 40 4 50

Wenn Sie die HOLD Taste nicht fiir 8 Sekunden gedriickt halten, wird der Speicher nicht geleert. Dies
verhindert, dass der Speicher unabsichtlich geléscht wird.

12 RS232 Protokoll

Baud Rate: 9600
Daten Bits: 8
Stopp Bits: 1
Paritat: Keine
Format: ASCII
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13 Batteriewechsel
Der Ladestand der Batterie wird im Display angezeigt

Batterie OK

Batterie leer

Wenn Sie die Batterien wechseln mdchten gehen sie wie folgt vor:

a. Schalten Sie das Gerat aus und entfernen Sie die Messleitungen von dem Messgeréat
b. Lésen Sie die Schrauben an dem Batteriefachdeckel

c. Entfernen Sie den Batteriefachdeckel

d. Nehmen Sie die alten Batterien aus dem Fach

e. Driicken Sie die FUNC Taste um Restspannungen aus dem Geréat zu lassen

f. Setzen Sie die neuen Batterien ein

g. Legen Sie den Deckel wieder auf und ziehen Sie die Schrauben fest

14 Wartung und Reinigung

Lésungsansatze und Reparaturen, die nicht in dieser Betriebsanleitung beschrieben sind dirfen nur von
geschultem und qualifiziertem Fachpersonal durchgefihrt werden.

Reinigen Sie das Gehause des Messgerates nur mit einem feuchten Tuch. Verwenden Sie keine
Scheuer- oder Lésungsmittel.
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15 Software

15.1 Betriebsvoraussetzungen
e PC mit dem Betriebssystem Microsoft Windows Vista / XP / 2000(SP3)
¢ NI-VISA Engine installiert (Wird automatisch bei der Software Installation installiert)
e Passender USB-Treiber installiert

15.2 Hardwarevoraussetzungen
¢ PC mit mindesten einem 600Mhz Prozessor
e Min.: 256 MB RAM Empfohlen: 512MB oder mehr
e Min. Bildschirmauflésung von 1024*768 Pixeln

15.3 Vorgehensweise beim Anschlie3en

1) Schalten Sie das Messgerat und den PC ein

2) Verbinden Sie das Messgerat via USB-Kabel mit dem Computer

3) Starten Sie das Programm des Netzanalysegerates

4) Wéhlen Sie den Seriellen Port aus, an dem das Gerat angeschlossen ist.

16 Software Installation

16.1 Programminstallation

Starten Sie die setup.exe auf der mitgelieferten CD. Danach startet das Installationsprogramm selbst-
standig. Folgen Sie den Anweisungen auf dem Bildschirm.

Hinweis:
e Nachdem Sie die CD in Ihr CD-ROM Laufwerk gelegt haben startet die CD automatisch
e Wenn das Programm erfolgreich installiert wurde starten Sie den Computer neu

16.2 USB-Treiberinstallation

Offnen Sie CD im Arbeitsplatz und starten Sie CP210x_VCP_Win2K_XP_S2K3.exe um die Installation
des USB-Treibers zu starten.

Hinweis:

e Falls die Hardware nicht erkannt wurde, entfernen Sie den Stecker aus dem USB-Port und
versuchen Sie es erneut
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17 Bedienung der Software

17.1 Starten der Software

Gehen Sie auf Start -> Programme -> CLAMP-ON Graphic Power Quality Analyzer um das Programm zu
starten.
Wahlen Sie den Port aus an dem das Gerét angeschlossen ist und klicken Sie anschlie3end auf Enter.

Wenn Sie nicht genau wissen welcher Port dies ist, kdnnen Sie dies im Gerate Manager nachschauen.

LA Pheane Enter Setial Port Number

Please Enter Serial Port Number

17.2 Funktionen im Hauptbildschirm
Gehen Sie in den Hauptbildschirm der Software.

LA CLAME.-ON Oimghlar Power Qrubity Asalyxes

Please select function from menu ...

B

1) In der Werkzeugleiste finden Sie Funktionen wie Einstellungen, Kommunikation zwischen PC und
Messgerat, Download von Daten vom Messgerat, Informationen und Beenden.
2) System Nachrichten werden hier dargestellt.

17.3 Einstellung der Parameter

Klicken Sie in der Werkzeugleiste auf File -> Setup um in die Einstellungen zu gelangen. Nachdem Sie
die Einstellungen im Programm vorgenommen haben werden diese in den Speicher des Messgerates
geschrieben.

17.3.1 Zeit und Datum

Klicken Sie auf den Button rechts vom Datum und der Uhrzeit, um diese einzustellen. Klicken Sie
anschlieRend auf OK um die Einstellung zu Ubernehmen.

29



BETRIEBSANLEITUNG PCE Instruments

17.3.2 Datenloggereinstellungen

Einstellméglichkeiten von Messwiederholungen (Sample), Start- und Stoppzeit (Start Time / StopTime)
und die Anzahl der Punkte im Diagramm (Waveform point)

17.3.3 Systemeinstellungen

Einstellmoglichkeiten von Voltage Transformator (VT), Referenzspannung fir Stérspannungen (TRANS
REF) und dessen Bereich (%), Frequenz (Hz), Demand Time (MD) und automatische Ab-schaltung (Auto
Power Off).

vT

TRANS REF

HZ 60 Hz (Auto) ~

MD Time

AUTO POWER OFF
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17.4 Kommunikation

Klicken Sie auf ,Communication® um in den Bildschirm fir die Kommunikation zu gelangen.

Um mit dem Gerét kommunizieren zu kénnen muissen sie den Messbereich auf 3 Phase, 1 Phase, V, A,
oder VA stellen.

[ Commansstion

Ranl Tow
Curtwnt Toe

In der Werkzeugleiste kdnnen Sie auswahlen, welche Funktion Sie benutzen wollen.

Datei 6ffnen (Open), Messdaten speichern (Save), Datei schlieRen (Close), Demand Time und die
Wiederholungsrate (MD Time & Sample Rate), Bildschirm drucken (Print), als Grafik anzeigen lassen
(Waveform) und Beenden (EXxit).

Angezeigt wird Ihnen die aktuelle Uhrzeit (Current Time), Startzeit (Start Time), Voltage Transformator
(VT), Frequenz (Hz), Demand Time (MD), Wiederholungsrate (Sample Rate), Anzahl der
Aufgenommenen Daten (Sample Count) und welche Messdaten zurzeit angezeigt werden (Present
Sample).

17.5 Download von Daten
Klicken Sie auf Datalogger -> Down Load Data (Strg+D) um Daten vom Messgeréat zu laden.

CLAMP-ON Graphic Fower Quality Analvzer

File Commmuncation  Datalogger  Help

Download ... {63.5 %)
Reset

Es wird angezeigt wie viel Prozent schon vom Gerat herunter geladen wurde.
Klicken Sie auf Reset um den Download abzubrechen.
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17.6 Speicher |6schen

Klicken Sie auf Datalogger -> Clear Memory (Strg+C) um in den Bildschirm zum Léschen der Daten zu
gelangen.

[ aEs)

File Commmnication Datalogger Help

Clear Memoxyr ?

Please sele« m menu ...

[Clear Memorv [ Cancel ]

Bestatigen Sie mit einem Klick auf ,,Clear Memory“ um den Speicher zu I6schen.

Achtung: Geldschte Daten auf dem Messgerat kdnnen nicht wiederhergestellt werden! Wenn Sie die
Daten bendtigen, laden Sie diese vorher vom Gerét herunter und speichern Sie diese auf dem Computer
(Kapitel 5.5).

18 Kommunikation mit dem Gerét
Die Software zeigt an, welche Daten aktuell auf dem Display des Messgerates dargestellt werden.
Wenn Sie die FUNC Taste dricken wird ausgewéhlt was angezeigt werden soll.

18.1 Kommunikationsbildschirm 1

Stellen Sie den Wahlschalter am Messgeréat in die Stellung ,3 Phase” oder ,1 Phase” und klicken Sie
anschlielen auf ,Communication“ um in den Kommunikationsbildschirm 1 zu gelangen.

1) Anzeige von Scheinleistung (S), Wirkleistung (P) und Blindleistung (Q)
2) Anzeige der Durchschnittsabnahme und der maximalen Abnahme
3) Anzeige von Leistungsfaktor (PF), PFF, Phasenwinkel, Leistung in PS (HP)
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18.2 Kommunikationsbildschirm 2

Stellen Sie den Wahlschalter am Messgeréat in die Stellung ,V* und klicken Sie anschlieen auf
,Communication“ um in den Kommunikationsbildschirm 2 zu gelangen.

1
2.2
3
5

1

| 2 ' 111.2

. ko 3 1 i e e D

100.0

1) Darstellung der Spannungskurve

2) Darstellung des Amplitudenspektrums

3) Darstellung der Schwingungen (Auswahlbar)

4) Anzeige der aktuellen Werte von RMS, Spitze (Peak) und THD
5) Anzeige von Starke und Prozentanteil

18.3 Kommunikationsbildschirm 3

Stellen Sie den Wahlschalter am Messgeréat in die Stellung ,VA® und klicken Sie anschlieRen auf
»,Ccommunication“ um in den Kommunikationsbildschirm 3 zu gelangen. Nachdem Sie die Messung fir
Strom und Spannung durchgefiihrt haben erhalten Sie folgende Anzeige auf dem Bildschirm:

846.7

——

—— 1.462
B
28.5

1) Anzeige von der Spannungs- und Stromkennlinie.
2) Anzeige der aktuellen Leistung (P), Scheinleistung (S) und Phase
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18.4 Kommunikationsbildschirm 4

Stellen Sie den Wahlschalter am Messgerét in die Stellung ,VA® und klicken Sie anschlieRen auf
»<communication“ um in den Kommunikationsbildschirm 4 zu gelangen. Nachdem Sie die Spannungs-
messung durchgefiihrt haben erhalten Sie folgende Anzeige auf dem Bildschirm:
. |
110.9

188.1

1) Anzeige der Spannungskennlinie
2) Anzeige des aktuellen RMS- und Spitzen- (Peak) wertes

18.5 Offnen und Speichern von Messdaten

Sie kénnen Daten von den Kommunikationsbildschirmen oder heruntergeladene Messdaten, vom
Messgeréat, speichern.

Hierzu klicken Sie: File -> Save (Strg+S) die aktuellen Daten werden dann als .csv —Datei gespeichert

SIS 8 115
TRSIME O 11

AVEALE WLl M c
HONGIR R Wenk

n ARULEE WA Ucxh 5 WoIrae of

I
1 TOOALTAOR 10 5L 1 | ke d SOSN8 6 11 L
12 WAE DAL L) eoche ) RIe 05 11 12
1 WRIR W 15k 1
" OIS O I 1Tk Y [
3 HOVCE DI 1S ok 47
I8 MG L] Wenk?Y ) ¢
14 MOV W Il Wk s donlh AOVE S LAY ewh §
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18.6 Einstellen der MD Zeit und der Wiederholungsrate
Klicken Sie auf File -> MD Time & Sample Rate und klicken Sie anschlief3en auf ,Setting”.

Are yon sure ©

| “Setting | | Cancel |

Danach erscheint folgendes Fenster:
Please Enter MD Time & Sample Rate _..

MD Time K

Sample Rate K
Cancel

Sie haben nun die Mdglichkeit die Parameter zu andern. Klicken Sie auf Enter um die Einstellungen zu
bestatigen.

Achtung: Gespeicherte Daten gehen mit dem Bestétigen verloren. Speichern Sie die Daten bevor Sie
MD Zeit und Wiederholungsrate andern.

18.7 Auswahlen des Druckers

Klicken Sie File -> Print. AnschlieRend klicken Sie auf ,V’ um den entsprechenden Drucker auszuwahlen.
Print :

WPCMHE Color Laserlet 2500 TP

18.8 Schwingungsverlauf

Klicken Sie im Kommunikationsbildschirm auf ,Waveform“ und wéahlen Sie aus welchen Verlauf Sie
angezeigt haben mdchten.

Kommunikationsbildschirm I: V, A, 'S, P, Q, PF, Phase, KVAH, KWH, KVARH, PFH, VA(AD),
W(AD), VA(MD), W(MD)

Kommunikationsbildschirm II: RMS, Peak, THD

Kommunikationsbildschirm 111 V, A, P, S, Phase

Kommunikationsbildschirm 1V: RMS, Peak
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18.9 Schwingungsverlauf aktualisieren

Sie kénnen im ,Waveform-Bildschirm®“ manuell die Skala und die Cursorposition verandern um die
Messwerte genauer betrachten zu kdnnen. Wenn Sie dies ausversehen gemacht haben kénnen sie das
wie folgt riickgangig machen um die komplette Schwingung zu betrachten.

Klicken Sie File -> Redraw und der Graph wird erneut angezeigt.

(B

Ta

Camel e Py O Tae [Vavs " S (o
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-
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138w 13k = 193000 2 3o Mo pRo 0nw
proeey Foarea TRt TowRg! por Pl e Xeama) anean
T

1) Wert der aktuellen Cursorposition

2) Anzeige des ausgewahlten Graphen

3) Andern der aktuellen Cursorposition

4) Kilicken Sie auf die Skala um den Bereich den Sie betrachten wollen zu verschieben

18.10 Schwingungsverlauf drucken

Klicken Sie auf File -> Print um den aktuell angezeigten Schwingungsverlauf auszudrucken.

18.11 Betriebsarten

Real Time Modus: Zeigt die aktuellen Daten im Kommunikationsbildschirm an

History Modus: Zur Betrachtung von vorher aufgezeichneten Daten. Es werden weiterhin Daten
gespeichert.

File Modus: Offnet gespeicherte Messdaten vom Computer
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18.12 Reset der Betriebsart

Gehen Sie auf View -> Reset. Die Daten, die aktuell angezeigt werden, werden ausgeblendet und die
Software geht in den Real Time Modus.

Bls  Wevelom JRFSS

Reol Tue CiidR
Wty J Hawy
Cuent ¥ Rl Mode O

1) Auswahl der Betriebsart und Reset der Betriebsart
2) Auswahl der aktuell angezeigten Messwerte (nur im History Modus mdglich)
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19 Entsorgung

HINWEIS nach der Batterieverordnung (BattV)

Batterien durfen nicht in den Hausmull gegeben werden: Der Endverbraucher ist zur Rickgabe gesetzlich
verpflichtet. Gebrauchte Batterien kdnnen unter anderem bei eingerichteten Ricknahmestellen oder bei
der PCE Deutschland GmbH zurlickgegeben werden.

Annahmestelle nach BattV:
PCE Deutschland GmbH
Im Langel 4

59872 Meschede

Zur Umsetzung der ElektroG (Ricknahme und Entsorgung von Elektro- und Elektronikaltgeraten)
nehmen wir unsere Gerate zuriick. Sie werden entweder bei uns wiederverwertet oder tber ein
Recyclingunternehmen nach gesetzlicher Vorgabe entsorgt.

20 Kontakt
Bei Fragen zu unserem Produktsortiment oder dem Messgerét kontaktieren Sie bitte die PCE
Deutschland GmbH.

Postalisch:

PCE Deutschland GmbH
Im Langel 4

59872 Meschede

Telefonisch:
Support: 02903 976 99 8901
Verkauf: 02903 976 99 8303

. ® CE| R’y
WEEE-Reg.-Nr.DE69278128 Ady v

WWW. pea-insiruments com

Alle PCE-Produkte sind CE
und RoHs zugelassen

38



